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Introduction

The Repliweb Family of Products

Helping your IT organization deliver strategic file workflow, content automation and information
delivery solutions faster, and more reliably. RepliWeb’s software solutions automate, guarantee,
and accelerate the delivery of files throughout local and distributed enterprise-computing
environments. Installed in some of the most demanding enterprise IT and data center
environments, RepliWeb solutions accelerate information availability, deliver improved
performance, and reduce costs associated with content-based file workflows.

Repliweb Deployment Platform (R-1) — Automated deployment of web content, 1IS 6
Metabase, 1IS 7 Configuration, .NET framework and COM+ components to data centers and
across local or distributed computing environments.

Repliweb Directory Synchronization (RDS) — A peer-to-peer file replication and file
synchronization solution for heterogeneous computing environment (Windows, Linux, UNIX).

Repliweb Operational Synchronization for SharePoint (ROSS) — Deployment solution for
SharePoint®-enabled organizations publishing across tiered topologies and multiple farms.

Repliweb Managed File Transfer (RMFT) — A managed file transfer platform that helps
organizations automate file workflows and accelerate the way they transfer, share, and
exchange files between internal users, customers, and business partners.

A complete list of products and supported platforms can be found at RepliWeb’s web site:
http://www.repliweb.com.

Repliweb Drive Mapper (RDM)

The Repliweb Drive Mapper (RDM) provides an out-of-the-box solution for mapping network
drives and devices through the use of background Windows services. Windows drive mapping
maps the drives interactively for a network user, rendering them ‘invisible' to a process running
in the background. RDM allows for other background processes (such as the Repliweb
Deployment Suite) to access the mapped resource while in background operation. If the
network drive or device is mapped using normal Windows drive mapping, the background
operation would fail as the mapped resource is only available to an interactive user (i.e. a user
currently logged on). In the case that no user is actively logged on to the machine, the mapped
drive would not even exist. RDM solves the above-mentioned issues and more, allowing
mission-critical processes that require the use of mapped drives and devices to proceed
unhindered.
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About the User Guide

Audience
This guide was written with the following in mind:

e The user is familiar with the various Microsoft Windows operating systems (Windows
2000/XP/2003/Vista, and Windows Server 2003/2008 — 32/64-bit Editions) and their basic
administration.

o The user has the necessary privileges for the computer(s) on which the software is to be
installed. These will be described more fully throughout the User Guide.

e The user is familiar with Windows-style graphical user interfaces (GUI) and / or
command line interfaces (CLI).

User Guide Organization

RDM can be administered indiscriminately through the use of a graphical user interface (GUI),
or a Command Line interface (CLI). All actions that can be performed using the GUI can also be
performed via Command Line. The respective interfaces simply provide a means of configuring
RDM to map the network drives and devices. For this reason, the concepts of Windows drive
mapping that are common to both interfaces will be discussed first, followed by separate
sections on implementation using both the GUI and CLI.
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Overview

Mission and Background Information

The purpose of RDM is to provide an out-of-the box solution to easily configure shared network
resources as 'background' mapped Windows drives. Although normal Windows drive mapping is
sufficient for network users, a mission-critical application running as a background process will
not be able to access the mapped drive. RDM was primarily developed to allow users of other
Repliweb products to incorporate shared resources and network storage appliances into
content deployment and data replication solutions.

Enterprise applications do not often run as interactive processes that appear on a user's
"desktop", but as background processes running as Windows services. They are not typical
applications in this sense. Windows services are started as soon as a system is fully booted,
and are active regardless of which user is 'logged on' to the machine. In fact, services are
already active when the Windows logon screen is displayed. In the case of a data-deployment
application such as RDS, it is fundamental to the solution that the replication be able to proceed
regardless of whether a user is logged on or not.

Windows maps drives 'interactively’, meaning that the drive will only be mapped while a user is
logged on to the system. When the user logs off, the drive no longer exists. What would happen
to a background application that relies on the mapped drive for content if the user were to log
off?

Another issue is that a mission-critical application running in the background (as a service), will
not "see" the network drive. This is regardless of whether a user is logged on (and the user can
see the drive in Windows Explorer for example) or not.

For a service to "see" the mapped drive it must be mapped in the context of a service - this is
done through the Repliweb Drive Mapper (RDM).

With Respect to Repliweb Replication Software

To successfully replicate to or from a mapped drive, the Repliweb Drive Mapper must be
installed and configured on the system that will map the resource. If normal Windows mapping
is used to map the drive, the background replication will not be able to access the mapped
drive.
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Architecture

When the Repliweb Drive Mapper service is started, it reads a configuration file specifying
which resources should be mapped to which drive letters, and what options to use (i.e. User
context, etc.). The configuration file is created and maintained by the RDM GUI and / or RDM
CLI. These details are discussed in subsequent sections of the User's Guide.

The user interacts with either of the interfaces (through the RDM GUI, or issuing the respective
RDM CLI commands) to automatically create / update the RDM configuration file. Depending on
the way the RDM service has been configured, the changes can take place almost immediately,
or the next time the RDM service starts.

ROM RDM
Administrator CLIGUI  Configuration
File =21 J: Yoexx\share
= = = K K WnetApp111imedia
‘ : = L L: WnetAppi12irichmedia
~—’ = M: M: WnetAppd 1dwideo
= T T: Wyyyishare

Figure 1: RDM Architecture

The RDM Service

The Repliweb Drive Mapper service is the component of RDM that actually performs the drive
mapping. To view a list of Windows services, open Administrative Tools (through the Control
Panel) and double click Services. By default, services are run under the privileged user
LocalSystem.

Information regarding choosing different user to run the service can be found in the Service —
Install section of this guide.

NOTE: Whenever the RDM service is stopped (i.e. for a restart), all mapped resources will be
brought down. Thus, ensure no processes are accessing the resource (i.e. no replication jobs
are running) whenever the service is stopped.

The RDM Configuration File

The RDM Configuration file holds all the information needed for RDM to perform the drive
mapping. Each drive has a separate section in the configuration file with information ranging
from the remote username and password (in encrypted form) necessary to access the shared
resource to the last error (if any) encountered when trying to map the drive.
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IMPORTANT:

The RDM configuration file is a file that is shared by all users on the system. When the RDM
service has been started and the drives successfully mapped, all drives mapped using RDM wiill
appear in Windows Explorer regardless of which user is currently logged in. However, access to
any of the mapped resources will be denied unless the user currently logged on to the system is
the same user whose credentials were used when defining the drive in RDM. This refers to the
user field when adding a new drive to RDM.

There is a maximum of twenty six drives (physical and mapped) available to a system, a
Windows limitation that must be taken into account when implementing a drive mapping
solution.

As previously mentioned, the RDM service reads the RDM configuration file every time the
service is started. The configuration file is automatically created and updated by both RDM
interfaces (GUI and CLI) whenever they are used to administer the drive mapping.

For configuration changes to be realized, the updated configuration file must be re-read by the
RDM service. If the service is set to Auto Refresh mode, no restart of the service is necessary.
If the service is set to Manual Refresh mode, the changes will not be realized until the service
has been restarted.

Accessing Mapped Drives

There are two possible ways a drive mapped using RDM may be accessed. The first deals with
an interactive user — a user that is logged on to the system and requires access to the mapped
resource. In this case, the user accessing the mapped drive must be the same user entered
in the user field or the access to the mapped resource will be denied.

The second case deals with a background process accessing the mapped resource. In this
case, the user accessing the resource must have the added permission Log on as a batch job
defined through Control Panel >Administrative Tools >Local Security Policy.

Applied to RepliWeb replication

Since all RepliWeb products operate through background services, the second case is
applicable.

= If the mapped drive is located on the Controller, the Controller user must have the
permissions mentioned above. This is the user entered in the Controller connection
dialogue box when starting the RDS GUI, or specified using the
—controller user qualifier using the RDS CLI.

= |f the mapped drive is on the Satellite, the Satellite user must have the permissions
mentioned above. This is the user field in the main job definition window.
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RDM Graphical User Interface (GUI)

The RDM GUI is the primary method for the user to configure any resources to be mapped
using RDM. Once RDM is installed, the RDM GUI can be started by selecting:

Start > Programs - Repliweb RDM > RDM

Starting the program brings up a graphical user interface that is used to generate and update
the RDM configuration file.

L=

Drive Service Wiew Help

Velx=l=2l luw &

Status | Drrive. | Resource Mame Description I Etror Message
4 ‘lcorporate server

TEEY

Ready [Service Is Instalied || Service is Running | [Service Auto Refresh Mode || 7 Seconds Refresh Tnterval || 5 Connected Drives |[Mo Disconnected Drives || 7

Figure 2: RDM Main window

The above screenshot is of the RDM GUI upon initial installation. The main window displays no
mapped resources; the service is installed and started.

The Status column displays the state the drive is currently in: Status Icon Status Description

Status Icon | Description

> -

The drive is connected.

The drive will be connected upon next service restart or refresh.

-Or-

An error has occurred and another attempt will be made to connect on
the next service restart.

The drive will be disconnected on the next service restart or refresh.

The drive will be deleted on the next service restart or refresh.

XX &

The drive is currently disconnected / disabled by user request.

H
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Status Icon

Description

The updated drive configuration will take hold on the next service
restart or refresh and the drive will be connected.

& &

The updated drive configuration will take hold on the next service
restart or refresh and the drive will remain.

The drive is defined as awaiting recovery in the system and is not
accessible.

= The Drive column displays the drive letter the resource has been assigned.

= The Resource Name column displays the resource the drive is mapping.

= The Description column displays the description assigned to the drive when it was

defined.

= The Error Message column displays the error message if there was a problem mapping
the drive. If the drive was successfully mapped, this field remains empty.
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The Drive Menu

Drive - New

i

—Drive Description

|§

Lagan By: companyiuser

Drive Letter: IEIZ "I
Resource Path: |1‘netapp1121media Elrnwse...l

Description: | Meclia on NETAPP112
Lizer: I compdomainicarpuser
Password: I T

|7 Auto Connect

Ok Cancel Help

Figure 3: Map Network Drive window

The Drive - New command will add a drive to the configuration file. The window that appears
requires the user to enter the information necessary to map the resource.

For the mapped drive to be successfully used, the user accessing the mapped drive must be
the same user entered in the user field.

= Logon By — This specifies the user currently logged on to the system. The user that
defines the new mapped resource is the “owner”. Although all users that start the RDM
GUI will be able to view the resources mapped by others, only the owner of a particular
map will be able to modify or delete the map. All other mapped drives will appear
“grayed out” in the main window.

= Drive Letter — The drive under which the shared resource should be mapped — only
available drive letters will appear from the drop-down list.

= Resource Path — The resource path to the shared resource — this should be entered
using a standard Windows shared resource. The field can be completed automatically by
browsing to the shared resource using the Browse button.

\\resource name\share name
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Example:
W22.123.555.2\media share

\\media serverl\media share

If the resource name is an IP address, it must be resolvable to an IP address. An easy way to
check is to open a DOS command prompt and issue: >ping resource name

If the pings are returned, the resource name can be resolved. If an error is reported, there is a
problem with the resource name.

For assistance in defining shared resources consult Windows Help.

= Description — The description field allows the user to write a description of the shared
resource for personal use. This field may be left blank.

= User — The user field supplies RDM with a username to access the remote resource.
This must be a user that has the necessary rights to connect to the shared resource.

For example: Domain User
Domain name\user name

For example: Local user

username

= Password — The password for user.

= Auto-connect — When this checkbox is clicked, the drive will automatically be
connected the next time the service is restarted. If the box is left unchecked, it will be in
a ‘disconnected / disabled’ state.

This feature may also be accessed by right clicking in the main RDM window.
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Drive - Update

Updates the configuration file for an existing drive. The drive to be modified must be selected in
the main window before this menu item is available. Selecting Update opens the same window
as selecting New, however the fields are filled with their last configuration.

This feature may also be accessed by right clicking in the main RDM window.

Drive - Delete

To delete a mapped drive from the configuration file select the drive in the main window and
select Delete. The delete must then be confirmed.

This feature may also be accessed by right clicking in the main RDM window and is applicable
to multiple drives if they are highlighted.

Drive - Connect

Sometimes it is necessary for a drive to be properly configured for mapping however put in a
“Disconnected” state (see Drive — Disconnect/Disable). This menu item reconnects a drive that
has been previously disconnected or disabled. This feature may also be accessed by right
clicking in the main RDM window and is applicable to multiple drives if they are highlighted.

Drive - Disconnect/Disable

A drive may be disconnected (i.e. unmapped) when the service is still running by choosing this
option. To disable a drive, select the drive in the main window and select Disconnect. The drive
may be reconnected (re-mapped) by selecting Connect from the Drive menu.

This feature may also be accessed by right-clicking in the main RDM window and is applicable
to multiple drives if they are highlighted.

Drive - Select All

Selects all the drives in the main window.

10
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The Service Menu

Service - Install

As mentioned, the RDM service is the component of RDM that actually performs the drive
mapping according to the information present in the configuration file. The service is installed by
default upon RDM installation. If this option is “grayed out”, it means the service has been
installed.

Installation Requiremen o ] |

—Instal &

{ System %

* szer I COmpany wser

Pazsword I T T T TIIIII 11

[V &Lto Start After Installstion;

[+ A&uto Refresh Every Cperation
[¥ &uto StartUp At System Boot

Ok I Cancel Help

Figure 4: Service Installation window

= |nstall As — A service is run by default as LocalSystem. To run the RDM service under a
different account, specify it in the user field. If the user is a domain user, enter the
username as \\domain name\user _name.

Ensure that the user has the following additional rights, added locally:
e Logon as a service.
e Act as part of operating system.
e Increase quotas.

e Replace a process level token to be assigned locally on the mapping machine.

To avoid permission and access issues, it is highly recommended to install the service as
LocalSystem.

For more information regarding the RDM service, see the previous relevant section in this guide.

11
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Auto Start After Installation — Once the service has been installed, it must still be
started before any drive mapping can occur. Selecting this option will automatically start
the service once it has been installed.

Auto Refresh Every Operation — Before any changes made to the configuration file
can be reflected, the RDM service must be refreshed. Under Auto Refresh, the service
will automatically refresh itself whenever a change is made to the configuration file
without disrupting the other mapped drives. When this option is turned off, no changes
made to the configuration file will take place until the service is restarted. During the time
the RDM service is being restarted none of the mapped drives will be available for other
processes.

RDM also has built-in recovery that will automatically attempt to re-establish a
connection with a shared resource if it is disconnected due to network issues. This
recovery only takes place when Auth Refresh is enabled. In the manual refresh mode,
any network outages that are repaired will not be reflected in RDM until the service is
manually restarted.

Auto Startup at System Boot — Enabling this option will automatically start the service
when the system boots up. Deselecting this option means a privileged user will need to
manually start the service each time the system is started.

Service - Uninstall

This feature will uninstall the service. The configuration file will still be preserved so that the
service can be reinstalled at a future date and the drives remapped.

Service - Start

Selecting this option starts the RDM service. The service must be started for any mapping to

occur.

Service - Stop

Selecting this option stops the RDM service. Any drives currently mapped will be unmapped.

Service - Restart

Selecting this option restarts the RDM service. This is equivalent to stopping and starting the
service.

12
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The View Menu

View - Toolbar

If checked, the toolbar will be viewable. The toolbar is located directly below the drop-down
menus and contains icons for commonly used menu items.

MiskEE b | m [ @|

Figure 5: RDM Toolbar

From left to right, the icons are:
New, Update, Delete, Connect, Disconnect / Disable
Start service, Stop service, Restart service
Help

View - Status Bar

The status bar is located at the bottom of the main RDM window. It contains important “at a
glance” information such as if the service is installed, started, in “Automatic refresh” mode, the
number of drives currently mapped, and the number of disconnected drives.

Ready [HENENNENNNENE [Service is installed | [Service is Running | | Service Auto Refresh Mode | |7 Seconds Refresh Rate | | 1 Connected Drives | |No Disconnected Drives | /

Figure 6: RDM Status Bar

If the service is in Manual Refresh mode, the respective indicator appears in red to remind the
user to manually restart the service if any changes have been made. This does not indicate that
there are any issues with the manual restart.

View - ToolTip

When this feature is activated, holding the mouse stationary over most icons and fields in RDM
will display a ToolTip describing the icon or field’s meaning. For more detailed explanations and
descriptions, consult the documentation or on-line help.

|Drive is properly mapped |

Figure 7: Sample ToolTip

13
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View - Refresh Interval

kY
— J | 0K |
0 Bl sec Cancel |
| normal refresh eveny: 10 zec. Help |
W Homat

Figure 8: Refresh Interval

The RDM GUI operates by reading and displaying the configuration file in graphical format. In
the same way that any changes made to the configuration file are not reflected in the mapped
drives until the service is restarted, any changes to the configuration file or updates to mapped
drives are not reflected in the RDM GUI until it has re-read the configuration file. The default
value is every ten (10) seconds, however it can be modified by sliding the slide bar to a different
value between zero (0) and sixty (60) seconds.

NOTE: The window can be manually refreshed by pressing the [F5] key, or right clicking the
main window and selecting Refresh.

The Help Menu

Help — Help Topics
Displays the online help.

Help — About RDM
Displays RDM Version and Copyright information.

14
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RDM Command Line Interface (CLI)

The Repliweb Drive Mapper command line interface allows all of the functionality of the
graphical user interface (GUI) available through a command prompt. The RDM CLI operates
under the same premise as the RDM GUI. Each command issues updates to the RDM
Configuration file. The changes will be reflected upon the next automatic or manual refresh of
the RDM service.

Since both interfaces work with the same configuration file, any changes to the configuration file
made through the CLI are reflected through the GUI, and vice versa. The two interfaces may be
used independently or hand-in-hand, as the solution requires.

It is recommended that the user be familiar with the operation of the RDM GUI before
attempting to use the CLI.

All RDM CLI commands are issued using the mapper executable from a command prompt
window.

Example:

Issuing a mapper command without any parameters leads to a help menu with all commands
and their usage.

C:\Program Files\RepliWeb\RDM\Bin>mapper
CLI-E-EMPSTR, empty string was passed to CLI
Usage
Service manipulations:
Mapper install [-user=james -pass=12345 —-[nolauto refresh
Mapper uninstall
Mapper stop
Mapper start
mapper restart
Mapper show
Drive manipulations:

Mapper add -drive letter=x: -resource=\\xxx\yy -user=james -pass=12345
[-[no]connect —-restart]

Mapper modify -old drive lerrer=x: -new drive lerrer=x: -resource=\\xxx\yy
—user=james -pass=12345 [-[no]connect -restart]

Mapper remove -drive lerrer=x: [-restart]

Mapper connect —-drive lerrer-x: [-restart]

Mapper disconnect -drive letter=x: [-restart]

Other manipulations:

Mapper help

Mapper show
RepliWeb Drive Mapper service is installed
RepliWeb Drive Mapper service is running
RepliWeb Drive Mapper service is auto refreshed
RepliWeb Mapped Drives
Available Letters for Mapping:

15
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An RDM CLI command is structured as follows:

>mapper <command> [-qualifier] [-qualifier] [parameter]

The <command> verb defines the requested action (install, uninstall, stop, start, restart, show,
add, modify, remove, connect, disconnect).

Most commands must be accompanied with qualifiers. Qualifiers in square brackets are
deemed optional. If they are not present, the default qualifiers will be used.

Example:
The following installs the RDM service under the default LocalSystem account with
manual service restart. Specifying a user and password would install the service under
the specified username:

>mapper install

Some qualifiers can be negated. These qualifiers have a - [no] in front of them.

The -connect qualifier will automatically connect the drive once the command has been
issued. The negated -noconnect would put the drive in the disconnected state.

16



RDM v2.2 User Guide RDM Command Line Interface (CLI)

RDM CLI: Service Commands

Install

The install command installs the RDM service.

-user=User

The user to install the service under. If the user is a domain user, it should be entered
using the domain\user format. If this qualifier, and the accompanying -pass qualifier
are omitted, the LocalSystem account is used.

Ensure that the user has the following additional rights, added locally:

e Logon as a service
e Act as part of operating system
e Increase Quotas

o Replace a process level token to be assigned locally on the mapping machine.
-password=PASS
The password for the above —user.
-[nolauto start

Once the service has been installed, it must still be started before any drive mapping can
occur. Selecting this option will automatically start the service once it has been installed.

The default is —noauto_start.
-[nolauto refresh

As has been stressed, any changes made to the configuration file will not take place until
the RDM service has been restarted. Selecting this feature will automatically restart the
service whenever a change is made to an existing drive, or a drive is added, deleted,
disconnected, or connected.

NOTE: When this option is selected, any changes made will take effect immediately,
meaning that processes accessing the mapped resources will be disrupted.

If this option is deselected, no changes will take place until the user manually restarts
the service.

The default is ~auto refresh.

Example:

>mapper install —-auto start -auto refresh
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Uninstall
Uninstalls the RDM service.

Example:

>mapper install
Drive Mapping service was successfully uninstalled

Stop
Stops the RDM setvice.
Example:

>mapper stop
Drive Mapping service was successfully stopped

Start
Starts the RDM service.

Example:

>mapper start
Drive Mapping service was successfully started

Restart
Restarts the RDM service.

Example:

>mapper restart
Service was successfully restarted.
RepliWeb Drive Mapping service was successfully restarted
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Show

Shows all information relating to drives the RDM service is mapping and the status of the
service itself.

Example:

RepliWeb Drive Mapper service is installed
RepliWeb Drive Mapper service is running
RepliWeb Drive Mapper service is auto refreshed
RepliWeb Mapped Drives

\james : [G:] -> \\NetApplll\Media disabled by request

\james : [S:] -> \\NetApplll\Rich media successfully mapped

Available Letters for Mapping:
[B:] [E:] [F:] [G:] [H:] [J:] [K:] [L:] [M:] [N:] [O:] [P:] [Q:] [R:] [S:]
[U:] [V:] [W:] [X:] [Y:] [Z:]

The command shows that the service is installed, running and operating under auto-refresh
mode. Thus when commands are issued there is no need to manually restart the service. The
command also displays the mapped drives. The first column shows the user that ‘owns’ the
drive mapping. Only user \james may alter the maps on drives G: and S:.

The first drive has been disabled by request, while the second is successfully mapped. The
command also lists the remaining drive letters available.

Any existing errors will appear after the drive’s state descriptions.
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RDM CLI: Drive Commands

Add

The add command adds a drive to the configuration file.

-drive letter=x:

The drive the network resource should be mapped under. The colon may be omitted.

-resource=\\resource name\share name

This should be entered using standard Windows shared resource. If the resource name
is an IP address, it must be resolvable to an IP address. An easy way to check is to
open a DOS command prompt and issue:

Example:

>ping resource name

If the pings are returned, the resource name can be resolved, if an error is reported,
there is a problem with the resource name.

For assistance in defining shared resources, refer to Windows Help.

-user=user name

The user field supplies RDM with a username to access the remote resource. This must
be a user that has the necessary rights to connect to the shared resource.

Examples:

Domain User: Domain name\user name
Local user: username

-password

The password for user.

- [no]connect

Connect the drive automatically when the service is restarted.
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"= -—restart

Restart the service after adding the drive to the configuration file.

= -—description=\"enter description here\”

A short description to describe the map. This qualifier is optional. Although the
description will not be seen from the CLI, it will be viewable from the GUI.

Example:

>mapper add —-drive letter=u: -resource=\\NetAppll4\video -user=acme\john -
password=12345 -connect -restart

Service successfully restarted.

Drive was successfully added to the configuration file

Modify

The modify command modifies a drive’s configuration settings, the command my be used to
change a drive’s drive letter, in which case both the old and new drive letter qualifiers must be
specified.

To modify another aspect of a drive such as a resource, username or password, simply use
the -new drive letter qualifier. This identifies the drive that the modifications should apply
to.

= -o0ld drive letter=x:

The drive the network resource is currently mapped to.

" -new drive letter=y:
The new drive the network resource should be mapped to.

The remaining qualifiers are identical to the add command and are used to modify that aspect
of the map.

For example, specifying —resource=\\newApp\share will overwrite the existing resource
field with the value \\newApp\share
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Remove

The remove command removes a drive and it's configuration settings form the configuration

file.

-drive letter=x:

The drive to remove from the configuration file.

-restart

Restart the RDM service after removing the drive from the configuration file.

Connect

Sometimes it is necessary for a drive to be properly configured for mapping however put in a
“Disconnected” state (See Drive — Disconnect/Disable). The connect command connects a
drive that has been previously disconnected or disabled.

-drive letter=x:

The drive to connect.

-restart

Restart the RDM service after connecting the drive so the updated configuration file is
read.

Disconnect

Sometimes it is necessary for a drive to be properly configured for mapping, however not to be
mapped although the service is installed and started.

-drive letter=x:

The drive to connect.

-restart

Restart the RDM service after disconnecting the drive so the updated configuration file is
read.
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